
Before Your 1st Backup
We have prepared this User’s Guide to help you get the most out of your Iomega Backup software.    Please read the following 
three sections before you begin your first backup.    These sections will give you a quick overview of Iomega Backup, helping you
decide which components will best meet your needs.
Introducing Iomega Backup  highlights the key features of Iomega Backup and will get you pointed in the right direction. 
Protecting all Your Stuff  is a “must read!” It contains very important information and instructions about preparing yourself and 
your stuff in case the ultimate disaster occurs—your computer wakes up one morning with a bad case of amnesia!
Navigating in Iomega Backup  lets you in on the mouse and keyboard navigational secrets that Iomega Backup has in store for 
you.



Introducing Iomega Backup
Iomega Backup will help you get the most out of your Jaz drive.    Iomega Backup’s key features include backing up your files to 
disks, restoring files from disks, comparing files on disks, copying files to disks, and archiving files on disks. 
Backup Up Your Stuff 
Restoring Your Stuff 
The Works and Your Stuff 



Backing Up Your Stuff
Iomega Backup gives you the choice between two backup methods.    Both of the options accomplish the same thing—your files 
are backed up and safe!    The difference is how much user interaction is involved.    
To help you decide which backup method is best for you, answer the following questions.
¨ Is this the first time you have performed a backup of your hard drive?
¨ Do you like working with a program that runs by itself and requires minimal interaction on your part?
If you answered yes to the questions above, then 1-Step Backup is the program for you!    It has been designed to maximize your
time, minimize your involvement, and still keep all your stuff safe!
If you answered no to the questions above, then you might be more interested in using the The Works.    It has been designed to 
give you a variety of backup options that can be mixed, matched, and scheduled according to your specific needs.
Regardless of your choice, you’ll be on your way to safeguarding your data with Iomega Backup.    

NOTE:    
Before running any backup function, please turn off all screen saver and virus checking programs.    These conflict with the 
backup process and may cause your computer to hang.



Restoring Your Stuff
The two methods available for restoring your files are similar to backing up your files. 1-Step Restore  is quick and easy like 1-
Step Backup.    If you want more options, use    Restore in The Works.



The Works and Your Stuff
The Works lets you choose among numerous options for the Backup, Restore, and Compare functions.    
In addition, you can do any of the following using The Works.
¨ Quick erase your Jaz disks
¨  Rename a disk or volume



Protecting all Your Stuff
Iomega Backup includes Disaster Recovery—a recovery utility that helps you recover from a complete system crash. (Disaster 
Recovery is only available for    Windows 95.)    However, for the Disaster Recovery utility to work, you must create Disaster 
Recovery diskettes.    Then, provided that you replaced all damaged hardware and that you formatted the destination drive 
properly, you can restore a system back to the way it was by booting off of the Disaster Recovery diskettes and running a restore
program to restore specific files, full volumes, or selected files. 
We recommend that you create your Disaster Recovery diskettes immediately and update them whenever you add to or change 
the configuration of your computer.
We also recommend that you print the sections of this help file with the instructions for recovery .
 
Creating Disaster Recovery Diskettes



Navigating in Iomega Backup
Using the Mouse
Standard mouse navigation can be used to navigate through both the main applications and the file trees. Use the left mouse 
button for selecting items and the right mouse button for pop-up menus.
When you are using a file tree, single clicking on drives and directories displays the sub-directories and files contained in them. 
Double-clicking on a drive or directory displays the sub-directories and files within it as well as expanding the branch beneath if 
applicable.
Holding down the left mouse button and dragging over multiple files or directories will highlight all those in the path of the cursor. 
The space bar can then be used to select all of the highlighted directories or files. 

Using the Keyboard

Tab Key
Use the Tab key to move through windows and access all the menus, push buttons, radio buttons, check boxes, edit fields, pop-
up menus, and drop-down list boxes.    
Direct Access Keys 
You can also use direct access keys to access all the menus, buttons, and boxes.    For example, to access the File menu, press 
Alt + F.    
Arrow Keys
When you are navigating in a file tree, the Up and Down Arrow keys will move you up and down through the trees, highlighting 
the directories or sub-directories.    The Right arrow key expands a branch and the Left arrow key collapses it.    
Space Bar
Pressing the space bar after highlighting items will select the items.    Pressing the space bar again will deselect the items.      



1-Step Backup
The combination of full backups and subsequent differential backups ensures that you always have a current backup of all the 
files on your computer.    
After every full backup, 1-Step will do approximately 10 backups on only the new or changed files. 1-Step Backup gives you the 
option to do a full backup about every tenth time, depending upon how often you add, edit, or delete files from your system. 
If you want to select individual files, directories, or drives for backup, use Backup Properties. 

To back up files using 1-Step Backup:

Select 1-Step Backup from the Iomega Backup menu (or right click on the 1-Step icon on your taskbar and select 1-Step 
Backup) and follow the on-screen instructions.
 



Backup Properties
Backup Properties lets you select the type of device for the backup, the kinds of files to back up, security options, and run 
options for your 1-Step Backups.    You can use this with 1-Step Backup to make your backups simple and easy.    
To use Backup Properties:
1 Select Backup Properties from the Iomega Backup menu (or right click on the 1-Step icon on your taskbar and select Backup 

Properties).    
2 Make any changes to the four tabs, General, File Selection, Security, and Run Options.
3 Click OK.

For more options than 1-Step offers    when backing up, use The Works.



1-Step Restore
Fast and easy, 1-Step Restore can restore files to your hard drive that have been backed up using 1-Step Backup. 

To restore files using 1-Step Restore:
1 Select 1-Step Restore from the Iomega Backup program group (or right click on the 1-Step icon on your taskbar).
2 Select the files you want to restore using one of the following methods: 1) Single-clicking with the left mouse button; or,    2) 

highlighting and pressing the space bar.
3 If necessary, click on the Alternate Path button and enter an alternate path for the restored files.
4 Click on the Restore Options button and select your options.
5 Click on the Restore Now button to restore the selected file(s).
6 Insert the disk as prompted by 1-Step Restore.



Backing Up Your Stuff in The Works
The Works gives you more control over the type of backup, the kinds of files, the backup options, and lets you define automatic 
backup schedules.
To access the Backup page, choose The Works from the Iomega Backup menu. A window displays with the Backup tab selected.
Follow the steps outlined below to create the backup settings file and begin the back up. 
1 Familiarize yourself with the toolbar buttons.    These will save you time as you create the backup settings file.
2 Create your backup settings files by choosing the type of backup and the files you want, or open an existing backup settings 

file.
3 Create a schedule for your future backups (optional).
4 Start the backup.

Using the Toolbar
Creating a Backup Settings File
Opening an Existing Backup Settings File
Starting the Backup Process



Using the Toolbar

New Backup Settings File
Creates a new backup settings file. If in Backup View, a prompt appears asking whether you want to save the current settings in 
a file before creating a new file.

Open Backup Settings File
Opens a saved backup setting file.

Save Backup Settings File
Saves the current backup and all its settings.

List View
Displays only files and icons in the directory window (no file details).

Details View
Displays detailed file information (e.g., creation date, file size) by columns in the directory window.

Parent Directory
Moves you quickly to the parent directory in the file tree.

Select Sub-Directories
Selects all sub-directories when the parent directory is selected.

Options Page
Displays the various options available for backup, restore, scheduler, error handling, and message log.

Message Log
Displays the message log file for the last disk operation.

Scheduler Log
Displays all backups currently saved in the Scheduler.

Scheduler
Schedules automatic backups.

Help 
Opens Help regarding the current task.

Help 
Displays Help for clicked on buttons, menus, or windows. 



Creating a Backup Settings File
A time-saving feature of Backup is the backup settings file.    Once created and saved, this file contains all the preferences 
you’ve selected for a particular backup (the type of backup, the kinds of files to back up, passwords, and volume names).    You 
can then use the file to schedule automatic backups.
1 To create a backup settings file, choose the Backup tab in The Works and begin making your selections as to the type of 

backup, passwords, volume names, and the files you want.    
2 When you are finished making all your choices, select Save from the File menu (or click the Save icon on the toolbar).    The 

Save As dialog box displays.
3 Enter a name for the settings file in the File Name text box. You do not need to enter a file extension; the extension “.fss” will 

automatically be added for you.
4 Click on the Save button.    
5 Your backup settings file is now saved and you can use it to schedule automatic backups, or you can begin a backup by 

clicking on the Start button on the Backup page. 

NOTE:    
It is not mandatory that you save the settings file.    If you choose not to save your settings file, only the current backup will 
function according to the settings you choose, and you will not be able to schedule automatic backups.

Choosing a Backup Drive
Choosing the Type of Backup
Selecting Files for Backup
Saving a Backup Settings Files



Opening an Existing Backup Settings File
1 To open an existing backup settings file, choose the Backup tab in The Works.
2 Select Open from the File menu or click on the Open toolbar button. The Open dialog box displays.
3 If you previously saved backup settings files in the default folder then all the settings files will be displayed in the Open box.      

Select the file you want and click on the Open button.    
4 If you saved a file in a different folder, use the Look In drop-down box to locate the folder containing the files.    Then select 

the file you want and click on the Open button.
¨ Use the Up One Level button to navigate between folders.
¨ Use the List button to list files without any details on creation date or size.
¨ Use the Details button to list files with creation date and size information.



Choosing the Backup Drive
The Device toolbar drop-down box displays the Iomega devices available to perform a backup. 



Choosing the Type of Backup
You can choose from among four different types of backups. 
If you want to make a comprehensive backup of individual files, directories, or drives, select one of the following from the Backup
Type drop-down box.

¨ Full: If you want a complete backup made of all the files selected, select Full.    (A full backup will take 
longer than an incremental or differential backup.)    

¨ Archive:    If you want to delete files from your hard drive, but have a copy of them on hand for future use,
select Archive.      If you select Archive, a compare will run automatically.    Only after a successful 
compare will the files be deleted from your hard drive.

If you only want to back up files that are new or have been changed since your last full backup, select one of the following from 
the Backup Type drop-down box.

¨ Incremental:  If you want to back up only the files that have been created or changed since the last full or
incremental backup, select Incremental.    

¨ Differential:    If you want to back up only the files that have been created or changed since the last full 
backup, select Differential. 

Recommended Backup Strategies 



Recommended Backup Strategies
We recommend you choose a backup strategy (either incremental or differential) and use it consistently.    If you combine 
incremental and differential, your restore process can become complicated.    

Using Full And Incremental Backups
When you use full and incremental backups, your backup time is shorter, but your restore time is longer.    For example, if you 
have one full backup and nine incremental backups, you need all nine incremental backups and the full backup to perform a 
complete restore.

Using Full And Differential Backups
When you use full and differential backups, your backup time is longer, but your restore time is shorter.    For example, if you 
have one full backup and nine differential backups, you only need that last differential backup and the full backup to perform a 
complete restore.



Selecting Files
Selecting files using Iomega Backup is fast and easy. The drives and directories are displayed on the left side of the box.    The 
directories or files of a selected drive or directory are displayed on the right side of the box. You can select files to back up, 
restore, or copy, by the drive or directory using your mouse.    The backup function also lets you use helpful include and exclude 
filters.
The drives and directories have a plus (+) sign or a minus (-) sign in front of them.    They also have a box with a check mark, 
without a check mark, or with a check mark in a gray box.    Below you will find explanations of these symbols and how to use 
them to select your files to    back up, restore, or compare.

What do the plus (+) and minus (-) signs mean?
A “+” in front of a drive or directory means that it can be expanded, allowing you to see all the subdirectories under it.    A “-“ 
means it can be collapsed.    Click once directly on the “-“ sign to change it to a “+” sign.    Click once directly on the “+” to 
change it to a “-“ sign. 

What do the check marks mean?
¨ A check mark in front of a drive, directory, or file means the whole drive, directory, or file has been selected.    
¨ An empty box with no check mark in front of a drive, directory, or file means the whole drive, directory, or file has not been 

selected.    
¨ A gray box with a check mark means that some of the subdirectories of the drive or directory are selected and some are not

selected.
¨ A red border on the box means that a filter is in effect for that directory or file.

Selecting Files with the Mouse
Locate the drive, directories, and files to be selected.    Click in front of the drive, directories, or files until a check mark appears 
(or a gray box and check mark).    Once the check mark appears, that item is selected.
Selecting Files for Backup Using the Include or Exclude Filters



Selecting Files Using the Include or Exclude Filters
1 Click the Include/Exclude Filters button to specify files to include or exclude. The Include/Exclude dialog box displays.
2 The Include/Exclude dialog box displays all the defined filters for the current backup settings file.    This list is displayed in the 

Filter List box.
3 Use the Filter drop-down list box to select Include or Exclude.
4 Select one of the following radio buttons, fill in the necessary information and click Add.

¨ By File Type:    Lets you include or exclude files by type, for example, all Excel files with the extension 
“.xls.”      If    you select this button, fill in the Path and File Extension text boxes.

¨ By Date:    Lets you include or exclude files by date: for example, all files with the date from 1/1/98 to 
1/31/98.      If you select this button, fill in the Path and the To and From text boxes.

¨ Specific File:    Lets you include or exclude files by specifying filenames.      If you select this button, fill in
the Path and Filename(s) text boxes.

5 Continue using the Include and Exclude filters, being sure to click on Add each time you complete one. As you add filters they
will appear in the Filter List box.

6 Move filters in the Filter List box up and down in priority by highlighting the filter and clicking on the Move Up or Move Down 
arrows by the side of the Filter List.

7 To delete a filter, highlight it then click the Delete button.    The filter is removed from the list.
8 To delete all the filters shown in the Filter List box, click Delete All.
9 When you have added and deleted all the necessary filters, click OK.    You will be returned to the Backup window.

NOTE:
Directories and files selected or deselected by a filter are shown with a red check box border.    In addition, any parent 
directory in the path of the applied filter will be displayed with a red border.    
The files or directories explicitly selected or deselected by a filter cannot be overridden in the file tree.    To remove filter 
selections or deselections, delete the filter or choose Clear from the Tree menu.



Defining Backup Options
Iomega Backup lets you choose any of the following options for your backup.    Click on the Options toolbar button then select 
the Backup tab.    
1 If you select Perform file-by-file auto compare after the backup, the program will compare the backed up files to the 

originals to make sure they match.    This ensures the integrity of the data.*
2 If you select Catalog backup in Librarian, the backed up files will be cataloged in the Librarian.    The Restore function uses 

the Librarian to help you find files—even if you don’t know which disk contains the file.    We recommend you use this feature.
3 If you select Backup a copy of the Librarian’s catalog to the disk, you’ll always have a copy of the Librarian—just in case 

anything happens to the Librarian on your hard drive.
4 If you select Compression, you can choose one of the following options.    

¨ None:    When you choose this option, you’ll have a faster backup time, but will use up more of the disk 
space.

¨ Optimized:    When you choose this option, you are picking a happy medium between backup time and 
disk space.

¨ High:    When you choose this option, you’ll use less disk space but the backup time will increase.
5 You need to choose one of the options under If backup already exists on the disk.

¨ Always append the current backup to the disk: Select this option and the backup will always be 
added to the end of the last backup.

¨ Always overwrite the disk with the current backup:    Select this option and the backup will always 
overwrite anything on the disk with the current backup. 

¨ Prompt me to choose between appending or overwriting:    Select this option and a prompt box will
appear when you begin a backup, giving you the choice between appending or overwriting. 

6 Click OK to apply the options you have selected. 

*A compare is automatically performed when doing an archive backup even if this option is not selected by the user.



Starting the Backup Process
After you have created or opened a backup settings file you are ready to begin the backup process.    
1 Select the Start button on the Backup page.    
2 If you have changed any of the backup settings, you will be asked whether or not you want to save the changes in the file.    

Click Yes or No.    
3 If you choose Yes, the Save As dialog box appears.    Enter a name for the settings file and click Save.
4 If you choose No, the backup process will begin—the screens that display will depend on the Backup Options you selected.    

NOTE:    
You must save the settings file if you want to use the Scheduler.

Saving a Backup Settings File
Saving a Backup Settings File with a New Name
Scheduling Backups
Appending or Overwriting disks
Backup Progress Screen



Creating a New Backup Settings File
To create a new backup settings file you must be on the Backup tab in Iomega Backup.    

1 Select New from the File menu.    (You may be prompted to save the backup settings file already on the screen.)
2 Begin selecting the backup settings you would like associated with the new settings file.

Choosing the Type of Backup
Selecting Files
Defining Backup Options
Scheduling Your Backup
Saving a Backup Settings File



Saving a Backup Settings File
After you have finished making the backup settings file, you will want to save it for future use.    (Also, you cannot use the 
scheduler without saving a backup settings file.)
1 To save your backup settings file, select Save from the File menu.    The Save As dialog box will appear.    
2 Enter a name for the settings file in the File Name text box. You do not need to enter a file extension; the extension “.fss” will 

automatically be added for you.
3 Click on the Save button.    



Saving a Backup Settings File with a New Name
1 To save your backup settings file with a different name, select Save As from the File menu.    The Save As dialog box will 

appear.    
2 Enter a name for the settings file in the File Name text box. You do not need to enter a file extension; the extension “.fss” will 

automatically be added for you.
3 Click on the Save button.    



Naming the Volume
Iomega Backup lets you enter a volume name and optional password for the backup.    

To name the volume and assign a password:
1 Click the Name/Password button on the Backup window.
2 Enter a name in the Volume Name text box.    
3 If you want the volume password protected, enter a password once in the Password text box and again in the Password 

Verification text box. 
4 Click the OK button.
If you do not enter a volume name for the backup set, Iomega Backup will use the default volume name of the backup type, date,
and time.    (Example below.)    

Full - 9/9/98 - 7:00PM



Scheduling Backups
Scheduling backups will automate the backup process for you.    You will not have to remember to start the backup—the program
will remember for you.
Scheduling is available through the Backup page of The Works or through the Scheduler button on the toolbar.    In order to use 
the Scheduler you must have created and saved a backup settings file.

To schedule automatic backups:
1 Click on the Schedule button on the Backup page or on the toolbar.      
2 Select a backup settings file using the drop-down box Backup to be scheduled. The seven most recently saved backups will 

be displayed in this list.    (If your backup settings file is not listed in the drop-down box, close the scheduler box, select Open 
from the File menu, and open the backup settings file you want to use.    Then return to the scheduler.)

3 Pick the frequency of the automatic backup:    Yearly, Monthly, Weekly, Daily, or Once.

¨ Yearly:    Enter Date and Time.
¨ Monthly:    Enter Date and Time
¨ Weekly:    Select the day of the week and enter the Time
¨ Daily: Enter the Time
¨ Once: Enter Date and Time

4 Choose Append disk or Overwrite disk in the Append/Overwrite Option drop-down box.    Choosing append or overwrite 
on this option page only applies to the current backup being scheduled and does not affect future scheduled backups.

5 Select the device to be used in the backup job in the Device drop-down box.
6 Click OK. 

NOTE:
After a backup job is scheduled, you must close The Works before the backup will run.



Defining Scheduler Options
Iomega Backup lets you choose any of the following options for your backup schedule.    Click on the Options toolbar button 
then select the Scheduler tab.    

You can define the following scheduler options:    

Scheduler Notification
If you want to be notified before a backup begins, select On and enter the amount of lead time in the Notify me box (in minutes).
If you select Off, scheduled backups will begin without notifying you.

Audible prompt
Select this option if you want the prompt to appear on your screen with a beep.

Prompt me when the scheduler is unable to run
If a backup cannot be run according to schedule, a prompt box will display.

Exit application after backup
Select this option if you want the program to close when the backup is complete.



Scheduler Notification Box
If you want to suspend the scheduled backup for an indefinite period of time, click Suspend.
If you want to extend the time before the backup begins, click Snooze.    The Snooze box displays.    
The scheduler notification dialog box requires no user interaction. If the user is not present when the notification goes off, the box
will display for 20 seconds, close automatically, and run the scheduled backup at the specified time. 



Snooze Dialog Box
You can use the Snooze Options to suspend the scheduled backup for a finite amount of time.    
Select one of the radio buttons in the Options box and click OK.

¨ 5 Minutes postpones the backup for five minutes.
¨ 10 Minutes postpones the backup for ten minutes.
¨ 15 Minutes postpones the backup for fifteen minutes.
¨ 20 Minutes postpones the backup for twenty minutes.
¨ Snooze until same time tomorrow postpones the backup until the same time the next day.
¨ Specific time postpones the backup for the number of hours (0-24) and minutes (1-59) you enter.

. 



Scheduler Log
The Scheduler Log under the Utilities menu and on the toolbar gives you a quick and easy way to view and manage scheduled 
backups.    From the Scheduler Log you an add, delete, suspend, activate, and edit scheduled backups. Use the OK button to 
close the Scheduler Log window and save the changes you made.



To add a saved backup to the schedule:
Click the Add button in the Scheduler Log dialog box.    The Scheduler dialog box displays.    Enter the applicable schedule 
information and click OK.    The backup will be saved and displayed in the Scheduler Log as active. 



To edit a scheduled backup:
Double-click on the scheduled backup in the list and make the changes necessary.    Click OK.



To delete a saved backup in the schedule:
Highlight the scheduled backup you wish to delete.    Click the Delete button.    The backup will be removed from the Scheduler 
Log.    



To activate all scheduled backups:
Click on the Activate All button.    Note the check marks that appear in front of the Status column.



To suspend all scheduled backups:    
Click on the Suspend All button.    Note that the check marks disappear from the Status column.
 



Appending or Overwriting Disks
At the beginning of the backup process the Append/Overwrite box may display.    (You can turn this box on or off using the 
Backup Options.)
This box displays the contents of the disk currently in the backup drive and gives you three options:

¨ Use Another Disk:    If you click on this option, you will be prompted to insert a new disk into the drive 
and click OK.    The new disk is read and the Append/Overwrite box will display again.    

¨ Append:    If you click on this option, the current backup will be added to the volumes already on the disk
and the Progress Backup window will display.

¨ Overwrite:    If you click on this option the current backup will overwrite all the contents of the disk and 
the Backup Progress    window will display.



Backup Progress Screen
Using the Backup Progress screen you can view the progress of the backup or cancel the backup.    
The Backup Progress screen displays the following information:

Backup Name
displays name of current backup.

Device
displays the type of device being used for the backup.

Percent Complete
indicates the percentage of the backup that is completed.

Compression Ratio
indicates the ratio for the compression of data.

Elapsed Time
displays the amount of time that has elapsed since the backup began.

Number of Items Selected
displays the number of items (files or directories) selected for the backup.

Number of Items Processed
displays the number of items (files or directories) backed up.

Bytes Selected
displays the total number of bytes selected for backup.

Bytes Backed up
displays the number of bytes currently backed up.

Transfer Rate (MB/minute)
indicates the transfer rate in megabytes per minute.

If you choose to cancel the backup, you will be prompted to verify the cancellation.



Restoring Your Stuff
Being able to restore any of your files will come in handy more often than you think.    After all, how many times have you deleted 
a file or emptied the “trash” only to discover a day or a week later that you really needed it?    Or have you ever loaded new 
software and had it destroy another program?    Then what do you do? Restore the files!    The backup and restore processes of 
Iomega Backup go hand in hand, making the recovery of archived, lost, or deleted files easier than ever before. If you have been
consistently backing up your stuff, then finding and restoring files, directories, or entire drives is a simple process.    

To start a restore:

1  Select the Restore tab in the The Works.
2  Find the files, directories, or drives you want to restore.
3  Select the files, directories, or drives to restore. 
4  Choose whether you want to restore the files to their original path or an alternate path.
5  Define the options for the restore.
6 Insert the disk containing the files as prompted.
7  Start the restore.
8  View the progress of the restore.

 



Finding Files on Your Back-up Disks

On the Restore or Compare pages, you can find files, directories, or drives on your backup disk using two 
methods:    from the Librarian or directly from the disk.
1 To view all the disks and files listed in the Librarian, select Librarian By Cartridge or Librarian By Drive from the View from 

drop-down list box. 

¨ The Librarian By Drive displays all the backup files (that have been added to the Librarian) as if you 
were looking at your hard drive.    In this view, only one copy of the file is displayed, even though it may 
actually exist on several different disks. (Several copies of a file could exist, differing only in backup 
dates¾only the most recently backed up file will display.)    

¨ The Librarian By Cartridge displays all the backup files by the corresponding disk that holds them.    In 
this view you can see what the volumes are on each disk and can open the volumes to see what drives, 
directories, and files are contained in them.

2 If you know which disk contains the files you want (or if you performed your backups without using the librarian), insert the 
cartridge into the disk drive and select Cartridge by Volume or Cartridge by Drive from the View from drop-down list box. 
This view displays the volumes (and the files inside the volumes) contained on the disk.

If you want to look at another disk, remove the current disk, insert another disk, and click View Another 
Cartridge.

After locating the files needed, select them using the instructions in the Selecting Files  section. 

Restoring to an Alternate Path
Defining Backup Options
Defining Restore Options



Choosing an Alternate Path
At the bottom of the Restore and Compare page is the Restore/Compare to Alternate Path check box.    If this check box is not 
checked, the files you select will be restored/compared in the paths they were originally backed up in. 



Defining Restore Options
The Works lets you choose any of the following options for your restore.    Click on the Options toolbar button then select the 
Restore tab.    
Select one of the options discussed below by clicking on the corresponding radio button, then choose OK to apply it to your 
current restoration process.    
The following options are available during the restoration of files.    

¨ Never overwrite the file on the hard drive: prevents the overwriting of a file that exists on the hard 
drive.    Thus, only files that do not exist on your hard drive, but which exist in the backup, will be 
restored.

¨ Always overwrite the file on the hard drive: lets the Restore process overwrite any file on your hard 
drive with the corresponding backup file (regardless of the date on the file).    Caution:    only use this 
option if you are sure none of the existing files on the hard drive are newer than the files on the backup 
disks.

¨ Overwrite the file on the hard disk only if it is older: lets the Restore process overwrite files on 
your hard drive that are older than the backed up version of the file.

¨ Prompt me to decide if I would like to overwrite the file: has the Restore process display a prompt 
box allowing you to decide on an individual basis which files you want to overwrite.

To revert to the default of “Prompt me to decide if I would like to overwrite the file” click the Default button and then OK.
To cancel any changes you have made and return to the Restore window, click Cancel.



Starting the Restore Process
1 After you have selected the files you want to restore and defined the restore options, click on the Start button on the Restore 

window.
2 If you selected files using the Librarian View, you will be prompted to insert the correct backup disk according to the name and

date.    After inserting the correct disk in the drive, click OK.    The restore process begins and the Restore Progress window 
displays.

Restoring Files with Password Protected Volumes



Files with Password Protected Volumes
If you choose to restore/compare files contained in a password protected volume, you will be prompted for the password when 
the restore/compare process begins and the disk is first read.    
In the Password text box, type in the password for the volume name displayed in the Volume Name text box.    Choose OK.

If the password is correct, the restore continues.    
If the password is incorrect, you are asked if you would like to try again.    If you choose Yes, you are returned to the 
Password box.    

¨ If you choose No and there are no more volumes to restore, the restore is canceled.    
¨ If you choose No and files remain to be restored from other volumes, you will be prompted with the 

choice of skipping the current volume or canceling the restore.    
¨ If you choose Skip, the restore continues, skipping the current password protected volume. 
¨ If you choose Cancel, another dialog box displays asking for confirmation of the 

cancellation.    If you choose Yes again, the restore process is canceled.    



Viewing the Progress of a Restore
The Progress—Restore screen appears after the Start button is selected on the Restore window and passwords for password 
protected volumes are entered.      This window shows while the restore is running and displays the following information.

Volume Name
displays name of current volume being restored.

Device
displays the name of the device used in the restore.

Processing File
displays the name of the file currently being restored.

Percent Complete
indicates the percentage of the restore that is completed.

Elapsed Time
displays the amount of time that has elapsed since the restore began.

Items Selected
displays the number of items selected for restoration.

Items Processed
displays the number of items restored.

Bytes Selected
displays    the total number of bytes selected for restoration.

Bytes Restored
displays the number of bytes currently restored.

Transfer rate
indicates the transfer rate in megabytes per minute.

During the restore process you may be prompted that a file already exists on your hard drive.    You are given the option of 
overwriting it or not.    If you choose Yes, the file on the hard disk is overwritten by the one that is located on the disk.    If you 
choose No, the original file on the hard disk stays and the file on the disk is not restored.    
See Restore Options for more information on the overwriting prompt.
Once the restore is complete, the Message Log is displayed with the statistics for the restore operation.
At any point during the restoration, you can stop the restore program by clicking on the Cancel button in the Progress—Restore 
window. If you choose Cancel, another dialog box displays asking for confirmation of the cancellation.    If you choose Yes again, 
the restore process is canceled.    



Overwriting File Prompts During a Restore
When Restore encounters a file on your hard drive with the same name as the file being restored an Overwriting prompt box may
display.

Select one of the following options and click OK to continue.

Overwrite this file
Restore will overwrite only the current file and the prompt will be displayed the next time Restore encounters a file with the same 
name.

Overwrite All
Restore will overwrite all files and the prompt box will not be displayed again. 

Overwrite if file on disk is newer
Restore will overwrite only the current file on your hard drive if the file in the backup has a more recent modification date.

Overwrite all if file on disk is newer
Restore will overwrite all the files on your hard drive that have newer files on the disk.    The prompt box will not be displayed 
again.

Don’t overwrite this file
Restore will not overwrite the file on your hard drive that has a newer file on the disk.    

Disable Prompting
Restore will not overwrite any files.    Thus only files that don’t currently exist on the hard drive will be restored.    The prompt box 
will be not displayed again. 



Comparing Files
The Compare function compares the files on disk to the files on your hard drive verifying that the information contained on the 
backup disk is identical to the data on the hard disk and that it can be restored. 

What does a Compare Do?
Starting the Compare Process



What does a Compare Do?

¨ Reads the data on your backup medium exactly as if it were going to restore the data to the hard disk.
¨ Compares this data to the data found on the hard disk.
¨ Verifies that they are identical or displays a message when files do not match. 

Tip:    
 We recommend that you always perform compares. This will confirm Iomega Backup is running properly on your computer.    
See Backup Options to compare automatically after every backup.



Starting the Compare Process
1  Select the Compare tab in Iomega Backup.
2  Find the files  you want to compare.
3  Select the files, directories, or drives to compare.
4  Choose whether you want to compare the files to their original path or an alternate path.
5  Start the compare.
6  View the progress of your compare.

If you selected files using the Librarian View, you will be prompted to insert the correct backup disk according to the disk name 
and date.    After inserting the correct disk in the Jaz drive, click OK.    The compare process begins and the Progress—Compare 
window displays.



Comparing Files in Password Protected Volumes
If you choose to compare files contained in a password protected volume, you will be prompted for the password when the 
compare process begins and the disk is first read.    
In the Password text box, type in the password for the volume name displayed in the Volume Name text box.    Choose OK.

If the password is correct, the compare continues.    
If the password is incorrect, you are asked if you would like to try again.    If you choose Yes, you are returned to the 
Password box.    

¨ If you choose No and there are no more volumes to compare, the compare is canceled.    
¨ If you choose No and files remain to be compared from other volumes, you will be prompted with the

choice of skipping the current volume or canceling the compare.    
¨ If you choose Skip, the compare continues, skipping the current password protected 

volume. 
¨ If you choose Cancel, another dialog box displays asking for confirmation of the 

cancellation.    If you choose Yes again, the compare process is canceled.    



Viewing the Progress of a Compare
The Progres Compare window appears after the Start button is selected on the Compare page and passwords for password 
protected volumes are entered.      This window shows while the compare is running and displays the following information.

Volume Name
displays name of current volume being compared.

Device
displays the name of the device used in the compare.

Processing File
displays the name of the file currently being compared.

Percent Complete
indicates the percentage of the compare that is completed.

Elapsed Time
displays the amount of time that has elapsed since the compare began.

Files Selected
displays the number of files selected for comparison.

Files Processed
displays the number of files compared.

Bytes Selected
displays    the total number of bytes selected for comparison.

Bytes Compared
displays the number of bytes currently compared.

Transfer rate
indicates the transfer rate in megabytes per minute.

Once the comparison is complete, the Message Log is displayed with the statistics for the compare operation.

At any point during the comparison, you can stop the program by clicking on the Cancel button in the Progress--Compare 
window. If you choose Cancel, another dialog box displays asking for confirmation of the cancellation.    If you choose Yes again, 
the compare process is canceled.    



Using the Menus in The Works

File Menu
Tree Menu
View Menu
Tools Menu
Utilities Menu
 



File Menu
New
Clears backup settings so that you can create a new backup settings file. 
Open
Opens an existing backup settings file.

Save
Saves the current backup file.

Save As
Saves the current backup settings file with a new name. 

Options
Opens the Options notebook in which you can define the options for backup, restore, scheduler, message log, and error 
handling.

Recent Files
Displays a list of the five most recently used backup settings files.

Exit
Exits the application.



Tree Menu
Select
Selects the current highlighted item in the file tree.    A check mark will appear in the box that corresponds with the highlighted 
item, including the file in the selection set for Backup, Restore, and Compare.
If Select Sub-directories is on, selecting a directory also selects all sub-directories and files contained in them.

Deselect
Removes the check mark from a selected item in the file tree, excluding the item from the file selection set that will be used for 
Backup, Restore, or Compare.

Clear
Clears the file tree of all selected items and applied filters.

Include/Exclude Filter
Lets you include or exclude specific files, files of a certain type, or files within a date range.

Parent Directory
Moves the highlight from the current directory to the parent directory.    

Select Sub-directories
Selects sub-directories when selecting parent directories.    



View Menu

Backup View
Changes The Works view to the Backup view.

Restore View
Changes The Works view to the Restore view.

Compare View
Changes The Works view to the Compare view.

View from Cartridge
Displays the catalog from disk; usable only in the Restore and Compare views.    This option is also controlled using the View 
From drop-down list box.

View from Librarian
Displays the catalog in the Librarian by drive letter; usable only in the Restore and Compare views. 

List View
Displays only the icon and filename in the directory window.

Details View
Shows detailed file information by columns in the directory window, e.g., name, size, type, modification date.

Status Bar 
Shows or hides the status bar.

Toolbar
Shows or hides the toolbar.



Tools Menu
For information on the Tool menu items, click on the topics below.

Read Disk Info
Quick Erase
Deleting Volumes
Rename



Read Disk Information
Select Read Disk Information from the Tools menu to display disk and volume information on the disk currently inserted into your 
drive.    In this box you can view the backups, volumes, directories, and files on a disk.    
Open and close folders on the left side of the box.    As you open folders, the files in the selected folder appear on the right side.
The Volume Information group box at the bottom of the screen displays the information for the volume that is currently 
highlighted or that you have expanded. 
The View New Disk button in the bottom left corner lets you get information from several different disks without having to close 
the window and start the operation over again.    When the button is pressed, the current information in the Disk Information 
window is cleared and the new disk is read.
Reading the new disk may take a few seconds.    A progress box displays while the disk read operation is performed.    To cancel 
the operation, click Cancel.



Quick Erase
Select the Quick Erase function in the Tools menu to compress the image file on your Jaz disk.
 
If you want to view the disk before continuing, click View Disk and the cartridge information will be displayed.
If you are sure you want to delete the information, click Continue.    The Quick Erase progress box displays and you can see the 
progress.    When the operation is finished a box displays indicating that the Quick Erase is complete.
Click the Cancel button to cancel the operation at any time.



Deleting Volumes from Disks
Use the Delete Volume function in the Tools menu to remove selected volumes on the disk.    
In the Delete Volume window select the volumes to be deleted by placing a check mark in the box that corresponds to the 
volume and then click the Delete button.
The Delete Volume progress box displays until the process is complete.    
Click the Cancel button to cancel the operation. 



Renaming a Disk
1 Select the disk you want to rename using one of the following methods:

¨ While in The Works on the Restore or Compare windows, view the disk from the Librarian or view from 
cartridge by drive and highlight the disk to be renamed.

¨ Insert disk, choose Read Disk Info from the Tools menu, and highlight the disk to be renamed.
2 Select Rename then Disk from the Tools menu (or right click and select Rename then Disk).
3 Type the new name in the New Name text box and choose OK.    The Rename Disk progress box will display.    



Renaming a Volume Name
1 Select the volume you want to rename using one of the following methods:

¨ While in Restore or Compare, view the volume from the Librarian or from cartridge by volume and 
highlight the volume to rename.

¨ Insert disk,    choose Read Disk Info from the Tools menu, expand the directory tree and select the volume
to be renamed.

2 Select Rename then Volume from the Tools menu (or right click and select Rename then Volume).    
3 Type the new name in the New Name text box and choose OK.    The Rename Volume progress box will display.    



Utilities
The following functions are available through the Utilities menu in The Works.

Librarian Maintenance
Message Log
Scheduler
Scheduler Log



Librarian Maintenance
To help minimize the size of the librarian’s database, we recommend you periodically use Librarian Maintenance in the Utilities 
menu to rebuild the librarian’s catalog of disks. 
The maintenance operation may take anywhere from thirty seconds to five minutes and cannot be canceled once it has started.   
However, you can minimize the progress window and continue working on other projects as it runs. 



Message Log
Use Message Log in the Utilities menu to display past statistics for recent disk operations.    The Message Log files can be 
displayed in simple text or in a graphical form using different colors and sizes of fonts.    These settings are controlled by the 
Message Log Options.



Defining Message Log Options
The Works lets you choose any of the following options for your Message Log.    Click on the Options toolbar button then select 
the Message Log tab.    
The following options are available for the Message Log.    Each disk operation (backup, restore, or compare) can be logged in 
the message log.
1 For each disk operation (backup, restore, or compare) select the type of log to be created.

¨ Detailed logs all sections.    
¨ Standard logs basic information and backup statistics.    
¨ Basic logs only the first section and not the backup statistics.

2 Select one of the following options that are available when creating a new log file:
¨ Append to data currently in the log
¨ Overwrite the existing data in the log 

3 Select Log in standard ASCI-text mode if you want the message log to format as an ASCI text file.    (Note:    All current data 
in the log will be lost if you choose this option.    A new log file will be created using the new format.)

4 Select Leave message log open after the cartridge operation if you want to view the message log immediately after a disk 
operation.

After you have made your selections click on OK.    
To reset the page to the default options, click on Default.



Scheduler
Selecting Scheduler from the Utilities menu opens the Scheduler box that will schedule automatic backups.



Scheduler Log
Selecting Scheduler Log from the Utilities menu opens the Scheduler Log box that displays all the backups currently saved in 
the scheduler. 
Using the Scheduler Log you can add, delete, suspend, activate, and edit scheduled backups.

Choosing Add will open the Scheduler Settings box.
Choosing Delete removes the currently selected backup from the log, eliminating it from the scheduler as well.
Choosing Activate All places a check mark in the Status checkbox of each backup in the log.    Individual backups that are 
scheduled can be activated or suspended by checking the box for the corresponding backup.
Choosing Suspend All suspends all the scheduled backups in the log.
Double-clicking on a scheduled back up in the log will let you edit it.
Choosing the OK button closes the Scheduler Log and saves the changes that were made.



Defining Error Handling Options
The Works lets you choose any of the following options for your error handling.    Click on the Options toolbar button then select 
the Error Handling tab.    
1 Enter the number of times you want the program to retry backing up files that are locked.    (Files may be locked because 

they are in use or because you do not have access to open the file.)
2 Enter the Wait time between retries (in seconds).
3 If you want to be prompted during the backup, compare, or restore, regarding an error, leave the Error prompting enabled 

box checked.    If you do not want to be prompted, and would rather see any errors reported in the message log, uncheck the 
Error Prompting Enabled box.

After you have made your entries click OK.    
To reset the page to the default options, click on Default.



Help Menu
Select About Iomega Backup  from the Help menu to view the version and registration information of your software.



Creating Disaster Recovery Diskettes
Each time you perform a backup using 1-Step Backup you will prompted to create or update your Disaster Recovery disks.    



1-Step Disaster Recovery
1 Insert your latest backup disk into your Jaz drive.
2 Insert the Disaster Recovery floppy diskette labeled Recover Disk into your A: drive and boot up your computer.    
3 If you installed a new hard disk or need to prepare your old hard disk, you can use the following tools located on the Recover 

Tools diskette. (If you still have a useable hard disk, try all other options to resolve the problem before continuing on with a full 
Disaster Recovery.)

At the a:/> prompt type in the name of the utility you need to run.
FDISK:    repartitions your hard disk(s) (a:/>FDISK).    If you use FDISK, you need to reboot off of the Recover Disk 
before using FORMAT or SYS or continuing to the next step.
FORMAT:    format one or more partitioned drives (e.g., a:/>FORMAT C:).
SYS:    Install the system boot files onto the hard disk (e.g., a:/>SYS C:).

4 After using the utilities, you must insert the Disaster diskette labeled Recover Disk and reboot.    The Disaster Recovery 
program will begin.    

5 Follow your on-screen instructions to complete the Disaster Recovery.



Backup Settings Files
A file containing all your backup preference choices regarding backup type, file selections, applied filters, passwords, and volume
names. You can create individual backup settings files for the different kinds of backups performed.    Once you have saved the 
settings in a file, you simply open the file and start the backup.



File Extensions
File extensions are the last three characters in a file name.    These are always preceeded by a period.    For example, if letter.doc
is your file name, ".doc" is the file extension. File extensions help identify the type of file; The Works uses ".fss" to indicate that a 
file is a backup settings file. 



Archiving Files
Do you need more space on your hard drive? Then delete some files! But first, because you never know when you'll need them, 
make an archive copy of the file on your archive disk.    In the future, if you need the file, it will be waiting for you, ready to be 
restored using the Restore function. 
Archive will automatically run a compare and files will not be deleted until the compare is successfully completed.



Full Backups
When you run a full backup, every selected file will be backed up.



Differential Backups
A differential backup will back up only the files that have been created or changed since the last full backup. 



Incremental Backups
An incremental backup will back up only the files that have been created or changed since the last full or incremental backup.



What is a "volume"?
A set of files created from a single backup operation.    Files from multiple drives can be stored in one volume. 



What is a "Compare"?
Compare analyzes the files on disk and compares them to the hard drive to verify that the data integrity has not been lost.



What does the "Librarian" do?
The Librarian catalogs all the backups according to volume and file name.    If you don’t know what disk your file is on, the 
information in the Librarian will be extremely valuable.    



What is the Scheduler?
The Scheduler lets you schedule automatic backups so you don’t have to remember to do them yourself.



General Reading Errors
1 Sometimes a segment on the disk cannot be read even after numerous retries.    During a backup or compare this means the 

backup was not successful – do another backup.    During a restore this will mean some files could not be restored.    This will 
normally affect only those files stored in that segment, the rest of the restore should be OK.    The following are suggested 
steps to restore the missing files. 

2 Close down any unnecessary applications, select only those files you wish to restore and restart the operation.
3 Shut down the computer, turn power off, then back on before restarting the operation.
4 If the problem persists on a particular disk, reformat it or discontinue use of the disk.



Specific Reading Errors    
5105
This is an error encountered reading or writing data.    The disk drive is reading segments that should not be on the current track. 
Getting this error means that the driver was unable to correct the situation.    Possible solution:  If the off-track error persists on 
a particular disk, reformat the disk or discontinue use of the disk.

5115
This is an error reading data.    The disk drive cannot read enough data from a disk segment to use error correction code.

5145
This is an error encountered reading or writing data.    More than one sector in the segment being read caused a CRC (Cyclic 
Redundancy Check) error on read.    The disk drive cannot read enough data from the disk segment to use error correction code.

5150
This is an error encountered reading or writing data.      The data for more than one sector in the segment being read caused a 
CRC error on read.    The disk drive cannot read enough data from the disk segment to use error correction code.

5152
This is an error encountered reading or writing data.    Part of the segment (called a sector) cannot be found on the disk.    During 
a read this is overcome by error correction code (ECC) unless too many sectors in a segment cannot be found.    During a write 
this error is only seen when attempting to write the header segment.

5154 & 5183
This is an error encountered reading or writing data.    Part of the segment (called a sector) cannot be found on the disk.    During 
a read this is overcome by error correction code (ECC) unless too many sectors in a segment cannot be found.    During a write 
this error is only seen when attempting to write the header segment.

5155
This is an error encountered reading or writing data.    A segment being scanned has a deleted address mark (deleted address 
marks are associated with the disk header and should not be in the data section of the disk).

5156
This is an error encountered reading or writing data.    A segment being scanned has an invalid or out-of-sequence address mark.
The driver should normally skip this segment during a backup.

5157
This is an error encountered reading or writing data.    A segment being scanned has been marked to indicate a bad sector. The 
driver should normally skip this segment during a backup.

5161
This is an error encountered reading or writing data.    The floppy controller terminated in an abnormal condition because it was 
using the wrong mode.   Possible solution:    If restarting the operation does not help, reboot the system (being sure to switch 
the power off before rebooting to reset the floppy controller). 

5176
This is an error reading data.    An error in the data for a segment has been detected but cannot be corrected by the error 
correction code (ECC). 

5182
A segment expected to contain data is marked as unused in the disk header.    This may indicate a corrupt header.



General Application Errors
1 If restarting the operation does not work, exit the application, restart the application and retry the operation.
2 If this does not work, turn the computer completely off and back on before trying again.
3 Uninstall and reinstall the application if this error persists.

5106, 5108, 5109, 5113, 5114, 5141, 5202
These are communication errors between the application and the driver.

1610, 1612
These are errors within the application that cannot be corrected.

5112
This is an error within the driver that the driver could not correct.

5144
The disk drive failed to respond in the maximum time allowed. 

5171
The disk drive is unable to accept any commands and will not reset.    On parallel port drives this may also indicate a problem 
with the parallel port configuration in the BIOS settings.  Possible solution: Try different parallel port modes in the BIOS settings
if this problem persists on a parallel port drive.



Notification Errors

5110, 1629
The disk has too many defects to be used reliably for safeguarding data--the backup will not complete.    Solution:    Use another 
disk.

5111
If backups have been done before to this disk using the same disk drive (and no hardware modifications have been made), first 
retry the operation. If this does not work, reboot the computer before trying again.    Uninstall and reinstall the application if this 
error persists.

5116
The operation was aborted by the user.

5146
The disk drive did not become ready and the driver was unable to successfully reinitialize the disk drive. Possible solution: If 
retrying the operation does not work, shut down the computer and turn power off (then on again) before rebooting to retry the 
operation.

5149
The floppy controller is reporting an attempt to seek past the last track. Possible solution:    If retrying the operation does not 
work, shut down the computer and turn power off (then on again) before rebooting to retry the operation.

5153
The disk in the drive has the write protect tab moved to the write protected position, preventing data from being written to the 
disk.    Solution:      Remove the disk from the drive and move the write protect tab out of the write protect position. 

5160
The floppy controller reported receiving an undefined or invalid command.

5162
A read or write operation was attempted, but there was no disk in the drive.    Possible solution: Be sure the disk is in the drive. 
5163, 1631
The disk is unformatted and cannot be read or written to.  Possible solution: If the disk drive supports the formatting operation, 
format the disk.    Otherwise a preformatted disk must be used.

5164
The driver is trying to seek (or has been requested by the application to seek) past the last valid data segment on the disk.     
Possible solution:    If retrying the operation and rebooting the computer do not work, the disk header may be corrupted.    When
encountering this problem during backup or compare, reformat or discontinue use of the disk.

5165, 1632
The disk has a format that is not supported or recognized by the application.  Possible solution: If the disk drive supports the 
formatting operation, format the disk.    Otherwise a preformatted disk must be used.

5166
The direct memory access channel specified in the application configuration settings is invalid.     Possible solution: Make sure 
the address is correct and retry the operation.

5169, 5201
The driver is unable to allocate enough memory to operate.    Possible solution:    Remove any unnecessary drivers and reboot.

5178
The disk type cannot be formatted by the disk drive. Possible solution:    Use a disk compatible with the disk drive. 

5203
The disk driver could not be loaded. Possible solution:    1)    Be sure to reboot the computer after installing the program.    2)    
Uninstall the software to remove any current drivers and reinstall the software. 3)    Under NT only an administrator can install the
software.    If this is not the case, log on as an administrator and reinstall the software.

1602
The volume table on the disk is full. Possible solution: The disk must be erased before additional backups can be made to the 
disk.



What is an image file?
Iomega backup writes an image file to your backup media when you are using Jaz disks.    This image file will temporarily 
consume the entire amount of available space on the disk.    When the backup is finished, however, the leftover space will again 
be available for data files. 



Failure to Complete
If your system cannot locate a Jaz drive that can read the disk, the backup or restore cannot be performed.    Check the cable 
and power connections.



General 1-Step Properties
On the General window of Backup Properties you can do any of the following:

¨ Enter a description of the backup job in the Description text box.
¨ Turn compression on or off by checking or unchecking the Compression ON box.
¨ Turn the 1-Step taskbar icon on or off by checking or unchecking the Always show the 1-Step taskbar Icon

box.
¨ View the backup history according to backup job and description.
¨ Reset the general settings to the original settings.



File Selection in 1-Step Properties
On the File Selection window of Backup Properties you can do any of the following:

¨ Click on the Select All button to select all files.
¨ Click on the Deselect All button to deselect all files.
¨ Click on the Filter button to use Include and Exclude filters
¨ Click on individual directories and files to select or deselect.
¨ Reset the file selections back to the original settings.



Security in 1-Step Properties
On the Security window of Backup Properties you can do any of the following:

¨ Turn on or off password protection.
¨ Enter a password to protect your backup files.
¨ Reset all Security settings to original settings.



Run Options in 1-Step Properties
On the Run Options window of Backup Properties you can do any of the following:

¨ Turn on and off the audible prompt associated with backup.
¨ Turn on and off the "Backup Complete" screen that displays when the backup is finished.
¨ Reset all Run options to their default settings.




